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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©November 2009

Trademarks
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
II
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.
III
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 3.42A or 18V, 3.5A (65 Watts) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
IV
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
V
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VI
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VII
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VIII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
X



Preface
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XI
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
XIII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Bluetooth, Wireless LAN, PC Camera, 3.75G/HSPA and Secu-

rity modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel Video driver controls.
• Appendix C The computer’s specification.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows Vista/Windows XP/Windows 7) and applications (e.g. word processing,
spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See Appendix A for a description of the interface (ports & jacks) which allow your computer to communicate with external
devices, connect to the internet etc.
Overview 1 - 3
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other 

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by 
the lid/LCD).

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu
in Windows Vista. This will help prevent hard disk or system problems.
1 - 4 Overview
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find that this manual refers to the Windows 7
operating system (however where necessary notes are provided on the Windows Vista OS).

Windows OS

In order to run Windows Vista/ Windows 7 without limitations or decreased performance, your computer requires a min-
imum 1GB of system memory (RAM).

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which includes Service Pack 2) be-
fore installing any drivers. Go to the Microsoft website for download details, or contact your service center.
Overview 1 - 5
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System Map: LCD Panel Open

Figure 1 - 2
LCD Panel Open

1. Built-In PC Camera 
2. LCD
3. Power Button
4. Hot Key Buttons
5. Keyboard
6. Built-In Microphone
7. Touchpad & 

Buttons
8. LED Indicators
9. Fingerprint Module 

(Optional)

8

2

4

1

6

7

3

5

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard air-
craft is usually prohibited. Make
sure the module(s) are OFF if you
are using the computer aboard air-
craft.

Use the key combinations to toggle
power to the 3.75G/HSPA/WLAN/
Bluetooth modules, and check the
LED indicator icon to see if the
modules are powered on or not
(see Table 1 - 4, on page 1 - 10/
Table 1 - 2, on page 1 - 7).

   Touchpad Buttons (valid operation area)

7

8
9
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LED Indicators
The LED indicators on the computer display helpful
information about the current status of the computer.

Table 1 - 1 - LED Status Indicators
Table 1 - 2 - LED Power & Communication Indicators

Icon Color Description

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & Scr Lk)

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Green The (optional) Wireless LAN 
Module is Powered On

Orange The (optional) Bluetooth 
Module is Powered On
LED Indicators 1 - 7



Quick Start Guide1

Hot Key Buttons & Keyboard
These buttons give instant access to the default Internet browser and e-mail program,
and allow you to toggle the Silent Mode on/off with one quick button press.

Table 1 - 3 - Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption.
Note this may reduce computer performance.

Hot Key Function

Activate the Default E-Mail Browser (Note that in Windows 7 this button 
will only function after Outlook or Outlook Express are installed)

 Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 8 Hot Key Buttons & Keyboard
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Keyboard
The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to
allow you to change operational features instantly. See Table 1 - 4, on page 1 - 10 for full function key combi-
nation details.

Figure 1 - 3 - Keyboard

Numerical Keypad 

Play/Pause Key

Function Keys NumLk & 
ScrLk Keys

Fn Key

Toggle Key

3.75G/HSPA Module
Power 
Keyboard 1 - 9
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Table 1 - 4 - Function & Hot Key Indicators

Keys Function Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F7 Display Toggle

Fn + 3.5G Module Power Toggle Fn + F8/F9 Brightness Decrease/Increase 

Fn + F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle 

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F11 WLAN Module Power Toggle 

Fn + F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle 

Fn + F4 Sleep Toggle *Silent Mode Toggle 

Fn + F5/F6 Volume Decrease/Increase 
*When enabled, Silent Mode will reduce fan noise and save power 

consumption. Note this may reduce computer performance.
1 - 10 Function/Hot Key Indicators
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System Map: Front & Left Views

Figure 1 - 4
Front & Left Views

1. LED Power & Com-
munication Indica-
tors

2. DC-In Jack
3. External Monitor 

Port
4. RJ-45 LAN Jack
5. e-SATA Port
6. HDMI-Out Port
7. Vent/Fan Intake/

Outlet
8. 2 * USB 2.0 Ports
9. ExpressCard Slot 

(see page 2 - 7)
10. 7-in-1 Card Reader

2 5
4

1

63

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)
\

7
8 9

108

1

System Map: Front & Left Views 1 - 11
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System Map: Right & Rear ViewsFigure 1 - 5

Right & Rear Views

1. S/PDIF-Out Jack
2. Microphone-In 

Jack
3. Headphone-Out 

Jack
4. USB 2.0 Port
5. Optical Device 

Drive Bay (for CD/
DVD Device - see 
page 2 - 3)

6. RJ-11 Phone Jack
7. Security Lock Slot
8. Battery

Disk Eject Warning

Don’t try to eject a CD/DVD
while the system is accessing
it. This may cause the system
to “crash”. Stop the disk first
then eject it, or press the stop
button twice.

1 52 4

8

3
6 7

CD/DVD Emergency Eject

If you need to manually eject a CD/
DVD (e.g. due to an unexpected
power interruption) you may push the
end of a straightened paper clip into
the emergency eject hole. Do not use
a sharpened pencil or any object that
may break and become lodged in the
hole. Don’t try to remove a floppy
disk/CD/DVD while the system is ac-
cessing it. This may cause the sys-
tem to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up
the control panel to allow you to adjust the regional
code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 12 System Map: Right & Rear Views
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System Map: Bottom View 

Figure 1 - 6
Bottom View

1. Battery
2. RAM & CPU Bay 

Cover
3. Vent/Fan Intake/

Outlet
4. Hard Disk Bay 

Cover

Note: the 3.75G/HSPA
USIM Card is located un-
der the RAM & CPU Bay
Cover.

2

3

1

4
3

3

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 11 for full in-
structions.

CPU
The CPU is not a user serviceable part.

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.
System Map: Bottom View 1 - 13
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure 1 - 7 - Start Menu & Control Panel

Click here to toggle Category View
 

1 - 14 Windows 7 Start Menu & Control Panel
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Windows Vista Start Menu & Control Panel
Windows Vista has a similar Start menu and set of control panels to that of Windows 7. To see all the Windows
Vista controls it may be necessary to toggle to Classic View on.

Figure 1 - 8 - Start Menu & Control Panel

Click here to toggle Classic View 
Windows Vista Start Menu & Control Panel 1 - 15
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Video Features - Win 7
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows 7. For more detailed video information see “Intel Video Driver Controls” on
page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropbox to select the screen Resolution  (Figure 1 - 9 on page 1 - 17).
6. Click Advanced settings  (Figure 1 - 9 on page 1 - 17) to bring up the Advanced properties tabs.

To access the Intel(R) Graphics and Media Control Panel:
1. Click Advanced settings  (Figure 1 - 9 on page 1 - 17) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab  (Figure 1 - 9 on page 1 - 17) and click Graphics Properties (button).
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel (see “Windows 7 

Start Menu & Control Panel” on page 1 - 14).

1
2

2

3

1 - 16 Video Features - Win 7
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Figure 1 - 9 - Screen Resolution & Intel® Graphics and Media Control Panel

1

2

3

Video Features - Win 7 1 - 17
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Video Features - Win Vista
You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista as long as the appropriate Intel video driver is installed. For more detailed vid-
eo information see “Intel Video Driver Controls” on page B - 1.

To access Display Settings control panel in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 10 on page 1 - 19).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 19).
5. Click Advanced Settings (button)  (Figure 1 - 9 on page 1 - 17) and click Intel(R) GMA Driver for mobile 

(tab).

To access the Intel(R) Graphics and Media Control Panel:
1. Click Advanced settings  (Figure 1 - 10 on page 1 - 19) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button)  (Figure 1 - 9 on page 1 - 17) to access the Intel GMA control panel.
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon   (Figure 1 - 10 on page 1 - 19) in the taskbar and select Graphics Properties from the 

menu.
OR
5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View (see 

“Windows Vista Start Menu & Control Panel” on page 1 - 15).

1
2

3

3
4

5

1 - 18 Video Features - Win Vista
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Figure 1 - 10 - Display Settings & Intel® Graphics and Media Control Panel

1 2

4

3

5

Video Features - Win Vista 1 - 19
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 13) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 11.

Figure 1 - 11 - Power Options
1 - 20 Power Options
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Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 7-in-1 Card Reader
• ExpressCard Slot
• TouchPad and Buttons/Mouse
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page C - 2) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location

21

3

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 2). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 12).

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical (CD/DVD) Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 12.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical (CD/DVD) Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 3
Left View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place (as 

pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard 
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

 Figure 2 - 4
Left View

1. Express Card 
Slot

 Figure 2 - 5
Inserting & 

Removing Express 
Cards

1

ExpressCard Slot 2 - 7
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
can configure the functions by double-clicking the TouchPad driver icon  on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 6
Mouse Properties
2 - 8 TouchPad and Buttons/Mouse



Features & Components

2
Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 7
Mouse Properties - 

Device Settings
TouchPad and Buttons/Mouse 2 - 9
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 8
Scrolling Gesture

 Figure 2 - 9
Zooming Gesture
2 - 10 TouchPad and Buttons/Mouse
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 10
Rotating Gesture

 Figure 2 - 11
Flick/Press 

Gesture
TouchPad and Buttons/Mouse 2 - 11
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar  icon bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 12
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
2 - 12 Audio Features
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 13
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 11.

Silent Mode

Use the  key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 9 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.

Win 7 Win Vista
Turning On the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 10 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
(Win 7)
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans (Win 7)

Click to Show/Hide 
additional 
power plans
Power Plans 3 - 5
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Figure 3 - 3
Power Plan 

Advanced Settings
(Win Vista)
3 - 6 Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7/ Win Vista use the Sleep, Hibernate and Shut Down power-sav-
ing states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.
Power-Saving States 3 - 7
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Win Vista Power 
Button

The Win Vista Power
Button  in the Start
Menu (in Classic View
use the Shut Down but-
ton ) can be used to
send the computer into
a power-saving state.

Figure 3 - 4
Start Menu Power Win 7 WinVista
3 - 8 Power-Saving States
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.

Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 5
Power Options 
Define Power 

Buttons

Win 7 WinVista
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

3.75G/HSPA 
Modules & System 

Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
3 - 10 Configuring the Power Buttons
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 3 on page 3 - 6).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 6
Battery Icon 

(Taskbar) & Battery 
Advanced Settings

Win 7 WinVista
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 7
Windows Mobility 

Center
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 8 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 11 for more information on how to maintain and properly
recharge the battery pack.)
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
3 - 14 Battery Information
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 9
Change Plan 

Settings / Change 
Advanced Power 

Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 10
Power Options 

Advanced Settings - 
Battery
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
3 - 18
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of
the computer’s subsystems. The system takes advantage of some newer hardware components for which the lat-
est versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system
components won’t be auto-configured with an appropriate driver or utility during operating system installation.
Instead, you need to manually install some system-required drivers and utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper
operation of the computer.

Module Driver Installation
The procedures for installing drivers for the Wireless LAN, 3.75G/HSPA, Fingerprint and PC Camera mod-
ules are provided in “Modules & Options” on page 7 - 1.

Make sure any modules (e.g. WLAN, 3.75G/HSPA or PC Camera) are ON before installing the appropriate driv-
er.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers/Option Drivers (button).

Figure 4 - 1 - Drivers Installer Screens
1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) 

which is the same as that listed in the Drivers Installer menu.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out. If you need to 

reinstall any driver, click the Unlock button (you should uninstall the driver first).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
 

4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
7 for instructions.

Driver - Windows 7/Windows Vista(SP2) Page

Chipset Page 4 - 5

Video Page 4 - 5

Audio Page 4 - 5

Modem Page 4 - 6

LAN Page 4 - 6

TouchPad Page 4 - 6

CardReader Page 4 - 6

Hot Key Page 4 - 6

Wireless LAN Module Page 7 - 12

3.75G/HSPA Module Page 7 - 24
Page 7 - 33

Fingerprint Reader Module Page 7 - 40

PC Camera Module Page 7 - 46

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2
(or a Windows Vista version which includes Service
Pack 2) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.
4 - 4 Driver Installation
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New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
Driver Installation 4 - 5
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Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. Click OK to restart the computer.
4. The modem is ready for dial-up configuration.

LAN
1. Click 5.Install LAN Driver > Yes. 
2. Click Install.
3. Click Finish.
4. The network settings can now be configured.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish > Restart Now to restart the com-

puter.

CardReader
1. Click 7.Install CardReader Driver > Yes.
2. Click Install.
3. Click Finish.

Hot Key
1. Click 8.Install Hotkey Driver > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

It is recommended you now install the MEI Drive (see
over).

Modem Country Selection

Go to the Phone and Modem (Options) control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
4 - 6 Driver Installation
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MEI Driver
1. Insert the Device Drivers & Utilities + User’s 

Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install MEI Driver > Yes.
4. Click Next > Yes > Next > Next.
5. Click Finish.

Windows Experience Index
After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index:

1. Click Start, and click Control Panel.
2. Click Performance Information and Tools 

(System and Security > System > Check the 
Windows Experience Index).

3. Click “Rate this computer”.
4. The computer will take a few minutes to assess 

the system performance.
5. Close the control panel.

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point 
to Settings and click Control Panel).

2. Click Check for updates (Security), or 
double-click Security Center and click 
Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates 

(you need to be connected to the internet).
5. Click Install now (button) to install the 

updates.
Driver Installation 4 - 7
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Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 2 - Drivers Installer - Option Drivers Menu

Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 2
for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 11, and check the installation procedure.

3.75G/HSPA Module
See the introduction in “3.75G/HSPA Module” on
page 7 - 20, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module”
on page 7 - 40, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 45, and check the installation procedure.
4 - 8 Driver Installation
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

1

2
3

4
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
5 - 6 Main Menu
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SATA Port 1/2 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of an HDD/optical de-
vice on the computer’s SATA Port 1/2. Use the Auto (Type:) setting to have the
items configured automatically for you.

System Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.
Main Menu 5 - 7
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Advanced Menu

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus in
non-USB aware operating systems.

Figure 5 - 3
Advanced Menu
5 - 8 Advanced Menu
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Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or Power-On
Self Test (see “The Power-On Self Test (POST)” on page 5 - 2).

Legacy OS Boot: (Advanced Menu)
Enable this item to support only system boot from the Legacy OS (e.g Windows Vis-
ta). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the audible warning when the battery has
reached low power status.
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu
5 - 10 Security Menu
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Set User Password (Security Menu)
You can set a password for user mode access to the PhoenixBIOS Setup Utility.
This will not affect access to the computer OS, (only the Setup utility) unless you
choose to set a Password on Boot (see below). Many menu items in the Phoenix-
BIOS Setup Utility cannot be modified in user mode. You can only set the user
password after you have set the supervisor password.

Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 5
Boot Menu
5 - 12 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu
Exit Menu 5 - 13
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1
2

3

1

3

2
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws  & .
3. Remove the hard disk bay cover .

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay 
Cover Removal

1 2
3

21

3
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4. Grip the tab and slide the hard disk in the direction of arrow .
5. Lift the hard disk out of the bay .

6. Remove the screw(s)  and the adhesive cover .
7. Reverse the process to install a new hard disk drive (do not forget to replace all the 

screws and covers).

4

Figure 6 - 3
HDD Assembly 

Removal

Figure 6 - 4
HDD Cover 

Removal

5

4
5

6 7

7
Hard Disk Screws & Cover

The hard disks and covers pictured
here may appear slightly different from
your model design (these designs are
subject to change and upgrade without
notice). Pay careful attention to the
screws (if included) and cover orienta-
tion.

6
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws  & .
3. Remove the hard disk bay cover .

Figure 6 - 5
Removing the HDD 

Cover

1 2
3

21

3
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4. Remove the screw at point , and use a screwdriver to carefully push out the 
optical device at point .

5. Reverse the process to install the new device.

Figure 6 - 6
Removing the 
Optical Device

4
5

4

5

5
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws  - .

Figure 6 - 7
CPU/RAM Bay 
Cover Screws

1 3

3

1

2
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3. Carefully (a fan and cable are attached to the under side of the cover) lift up 
the bay cover.

4. Carefully disconnect the fan cable , and remove the cover .

5. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 10.

Fan Cable & Cover

Make sure you reconnect
the fan cable  before
screwing down the bay cov-
er. Note the information on
replacing the RAM & CPU
bay cover in “Cover
Pins” on page 6 - 11.

Figure 6 - 8
CPU/RAM Bay 

Cover Removed

Figure 6 - 9
RAM Module 

Release

4

4 5

5

4

6 7

6 7

Contact Warning

Be careful not to touch the metal pins on the
RAM module’s connecting edge. Even the
cleanest hands have oils which can attract
particles, and degrade the module’s perfor-
mance.
Upgrading the System Memory (RAM) 6 - 9
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6. The RAM module will  pop-up, and you can remove it.
7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module 
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

Figure 6 - 10
RAM Module 

Removal

Single Memory 
Module Installation

If your computer has a
single memory module,
then insert the module
into the Channel 0
(JDIMM1) socket. In this
case this is the lower
memory socket (the
socket closest to the
mainboard).

8

8
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11. Replace the bay cover and screws (make sure you reconnect the fan cable 
before screwing down the bay cover).

12. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.

Cover Pins

Note that there are cov-
er pins need to be
aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover
(see Figure 6 - 11).

Figure 6 - 11
Cover Pin 
Alignment
Upgrading the System Memory (RAM) 6 - 11
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Bluetooth Module
• Wireless LAN Module
• 3.75G/HSPA Module
• Fingerprint Reader Module
• PC Camera Module

Wireless Device 
Operation Aboard   

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Important Notice

If your purchase option in-
cludes both Wireless LAN
and 3.75G/HSPA modules,
then the appropriate anten-
nas will be installed. Note
that In order to comply with
FCC RF exposure compli-
ance requirements, the an-
tenna must not be co-
located or operate in con-
junction with any other an-
tenna or transmitter.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
Overview 7 - 1
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Bluetooth Module
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows Vista, and therefore does not require a driver. Use
the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 -
10) to toggle power to the Bluetooth module. When the Bluetooth module is pow-
ered on, the  LED will be orange and the on-screen indicator will briefly be dis-
played.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 4, on page 1 - 10/ Table 1
- 2, on page 1 - 7).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
7 - 2 Bluetooth Module
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Configuration in Windows 7
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.
• Click/Right-click the taskbar icon  and choose an option from the menu.

Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

Figure 7 - 1
Bluetooth Devices & 

Click Icon Menu

Add a device

Right-Click Taskbar Icon 
Bluetooth Module 7 - 3
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 2
Add a Device
7 - 4 Bluetooth Module
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure 7 - 3
Pairing Code 

Example

Figure 7 - 4
Pairing Complete & 
Bluetooth Device 

Enabled

Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 5
Bluetooth Settings - 

Options
7 - 6 Bluetooth Module
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Bluetooth
Settings > Options, and
make sure that Show the
Bluetooth icon in the
notification area check
box (Connections) has a
tick inside it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure 7 - 6
Bluetooth Devices & 

Click Icon Menu

Bluetooth SettingsAdd Wireless Device
Bluetooth Module 7 - 7
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Bluetooth Settings.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it, and click OK.
3. Click Add Wireless Device in the Bluetooth Devices control panel.
4. Double-click the device you want to pair with the computer.

5. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 7
Pair with a wireless 

device
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6. Enter the code into your Bluetooth enabled device and follow any on-screen 
instructions to complete the pairing.

7. Windows will check to see if any drivers are required to complete the pairing. 
8. Follow any on-screen instructions on the computer if device drivers are required to 

be installed.
9. Click Close.

Figure 7 - 8
Pairing Code

Figure 7 - 9
Pairing Complete & 
Bluetooth Device 

Enabled

Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 9
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth 

devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 10
Bluetooth Settings - 

Options
7 - 10 Bluetooth Module
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 5300 Series, 3rd Party 802.11b/g or 3rd
Party 802.11b/g/n WLAN module in your purchase option, make sure that the Wire-
less LAN module is on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 10) to toggle power to the Wireless LAN module. When the WLAN module is
powered on, the  LED will be green and the on-screen indicator will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 4, on
page 1 - 10/ Table 1 - 2, on
page 1 - 7).
Wireless LAN Module 7 - 11
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. An on-screen message will appear to show the progress of the WLAN 

installation.
5. When the message disappears the driver will be installed.

3rd Party 802.11b/g/n or 802.11b/g/n Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see “Connecting to a Wireless Network in Windows 7” on page 7 - 13 or
“Connecting to a Wireless Network in Windows Vista” on page 7 - 16).
7 - 12 Wireless LAN Module
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on.
1. Click the taskbar wireless icon , and then double-click an access point to con-

nect to or click to Open Network and Sharing Center if you do not see a network 
you want to connect to in the taskbar menu (a list of options will appear allowing 
setting changes, and creating a new network).

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 11
Click Taskbar Icon 
Menu & Network 

and Sharing Center
Wireless LAN Module 7 - 13



Modules & Options

7

2. You may need to enter a security key for any access point to which you are trying 
to connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access 

further options for the connection.

Figure 7 - 12
Network Location 

Set
7 - 14 Wireless LAN Module
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon

, click the active connection and then click Disconnect (button). Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure 7 - 13
Click Taskbar Icon 
Menu - Disconnect
Wireless LAN Module 7 - 15
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Connecting to a Wireless Network in Windows Vista
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 14
Taskbar Menus

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 15
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 16
Connecting

Figure 7 - 17
Connection Status
Wireless LAN Module 7 - 17
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).

Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 18
Disconnecting

Click icon

Right-click icon
7 - 18 Wireless LAN Module
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 19
Windows Mobility 

Center
Wireless LAN Module 7 - 19
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3.75G/HSPA Module
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
(see “Communication” on page C - 3 for specification details) in your purchase op-
tion, you will have the appropriate application (HSPA Modem Interface or Mobile
Partner) provided for your particular module. Follow the instructions on page 7 -
22 to install the USIM card (supplied by your service provider), and then install the
application (see over for further details).

3.75G/HSPA Module 
Options

There are two optional
3.75G/HSPA modules
available for this series of
computer models. Each
module is supplied with the
appropriate application
software.

The module type supplied
may depend upon the com-
puter model purchased.
Check with your service
center for details.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
7 - 20 3.75G/HSPA Module
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see “Function/Hot
Key Indicators” on page 1 - 10) to toggle power to the 3.75G/HSPA module.
When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be
displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3. Note that exiting the application does NOT turn off the 3.75G/HSPA
module.

• HSPA Modem Interface - See “HSPA Modem Interface Installation” on 
page 7 - 24 for driver installation information and “HSPA Modem Interface” 
on page 7 - 25 for instructions on using the HSPA Modem Interface.

• Mobile Partner - See “Mobile Partner Application Installation” on page 7 - 
33 for driver installation information and “Mobile Partner Application Installa-
tion” on page 7 - 33 for instructions on using the Mobile Partner application.

3.75G/HSPA 
Modules & System 

Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
3.75G/HSPA Module 7 - 21
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Installing the USIM Card
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws  - .
3. Carefully (a fan and cable are attached to the under side of the cover) lift up 

the bay cover.
4. Carefully disconnect the fan cable , and remove the cover . 

Power Safety 
Warning

Before you undertake
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Figure 7 - 20
SIM Card Cover/

RAM & CPU 
Bay Cover Removal

1 3

4 5

2

1

3

4

5

Fan Cable

Make sure you re-
connect the fan cable

 before screwing
down the bay cover.
4
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5. Insert the USIM card as you would into your mobile phone.
6. Slide the SIMLOCK towards the hinge in order to release the lock and lift it up.
7. Insert the USIM card as illustrated in (Figure 7 - 21) and close the SIMLOCK.

8. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 22 until 
it clicks into the lock position.

9. Replace the covers and screws (reconnect the fan cable before screwing down 
the bay cover see sidebar for note on cover pins).

Figure 7 - 21
Insert the USIM 

Card

Figure 7 - 22
SIMLOCK Lock

Cover Pins

Note that the cover pins
need to be aligned with
slots in the case to insure
a proper cover fit, before
screwing down the bay
cover.
3.75G/HSPA Module 7 - 23
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HSPA Modem Interface
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the HSPA Modem Interface. The HSPA Modem In-
terface allows you to directly access your HSPA internet service from the computer.

HSPA Modem Interface Installation
1. Enable power to the module by pressing the Fn +  key combination (give 

the module about 10 seconds to power on and the on-screen icon will indi-
cate the module’s power status). 

2. If a Found New Hardware window appears, click Cancel in all windows 
that appear, and then proceed to install the driver as below.

3. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

4. Click Option Drivers (button).
5. Click 3.Install 3G Driver > Yes.
6. Click Next > Next > Install.
7. Click Finish to restart the computer.
8. Access the HSPA Modem Interface from the Start menu (Start > Pro-

grams/All Programs > HSPA modem), or by double-clicking the HSPA 
modem icon on the desktop.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 4, on page 1 - 10/ Table 1
- 2, on page 1 - 7).
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HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service pro-
vider.

1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop 
icon .

3. If a USIM card is not installed then a message will appear to notify you of this (click 
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to 
enter a pin #. (Note: to change pin # go to Settings  and click OK in PIN 
code.)

5. Click the Network connection  button and the HSPA Modem interface 
window will display Connection Manager.

HSPA Modem Help

To get help on 3.75G/
HSPA module configu-
ration and settings, click
the help icon  and
select Help.

Figure 7 - 23
HSPA Modem 

Interface Window

Connection Manager

The connection information is commonly stored on the USIM
card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect  to connect to your service provider.

7. The message “Network is connected” will be displayed when the network 
connection is successful. 

8. You can then access the internet, download e-mail etc. as per any internet 
connection.

Figure 7 - 24
Connecting to 

Network

Figure 7 - 25
Network is 
Connected
7 - 26 3.75G/HSPA Module



Modules & Options

7

9. While you are connected the upper right corner of the HSPA Modem interface will 
display the upload and download rates, and the taskbar icon will display the 
connection information.

10. To disconnect click the Disconnect  icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn +  key combination 

to turn it off.

Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection , and click Profiles (tab).

Figure 7 - 26
Uploading/

Downloading Rates 
and Speed

Figure 7 - 27
Profiles

Win Vista Win 7
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3. Click Add (button) and input any Network Settings required by your service 
provider.

4. Click OK to save the profile.

5. You can Edit or Delete profiles from the Profiles tab.
6. To use a profile click to select it, and then click Apply (button) and the settings will 

be transferred to Connection Manager.

Figure 7 - 28
Network Settings & 

Profiles
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Contacts
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts  (button).

3. Click Refresh (button) to download the contacts from the USIM card to the 
computer.

4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.

Figure 7 - 29
Network Settings & 

Profiles
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Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages  (button).

3. Click Refresh (button) to download the messages from the USIM card to the 
computer.

4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To 

(button) to select the contact from the list.

SMS Service

In addition to standard in-
ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure 7 - 30
Network Settings & 

Profiles
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6. Click to select a contact from the list and then click Add (button) and the phone 
number will automatically be added to the recipient field.

7. Type the message information into the message body and click Send (button) to 
send it, or Save to draft (button) to save the message.

8. Select any message to forward or delete it, or to reply to it.

Settings
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings  (button).

Figure 7 - 31
Settings
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3. Click OK alongside any of the options to configure the settings.
4. The Network can be configured for an Automatic (usually from the USIM card) or 

Manual connection.
5. The Network Mode can be configured for any appropriate mode required.

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will 

need to press the Fn +  key combination to turn off the module (pay careful 
attention to this aboard aircraft - see “Wireless Device Operation Aboard 
Aircraft” on page 7 - 24).

8. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 32 
Settings - Network/

Network Mode
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Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation
1. Enable power to the module by pressing the Fn +  key combination (give 

the module about 10 seconds to power on and the on-screen icon will indi-
cate the module’s power status). 

2. If a Found New Hardware window appears, click Cancel in all windows 
that appear, and then proceed to install the driver as below.

3. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

4. Click Option Drivers (button).
5. Click 3.Install 3G Driver > Yes.
6. Choose the language you prefer and click OK.
7. Click Next > I Agree (button) to accept the license agreement.
8. Click Next > Install.
9. Click Finish to restart the computer.
10. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the 
Mobile Partner icon on the desktop.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 4, on page 1 - 10/ Table 1
- 2, on page 1 - 7).
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Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. If you have not created a profile, click Tools and select Options, and then click 
Profile Management.

4. Click New  and input the appropriate information for Profile Name, APN 
and Authentication etc. as supplied by your service provider.

5. Click Save  to save the profile.

Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure 7 - 33
Profile Management
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. The software will run and you can select the Profile Name from the menu.
4. Click Connect  to begin the connection process.

5. The Mobile Partner application will then display the connection information.

Figure 7 - 34 
Connect

Figure 7 - 35
Network 

Connection Prompt
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6. When the connection is successful you can move the cursor over the network icon 
in the taskbar to display the connection information.

7. You can then access the internet, download e-mail etc. as per any internet 
connection.

8. While you are connected the indicators in the Mobile Partner window will display 
uploading and downloading icons and a network icon in the taskbar .

Figure 7 - 36
Connected 

Taskbar 
Notification

Win Vista Win 7
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9. To disconnect click the Disconnect  icon, or right click the taskbar icon 
and select Disconnect.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn +  key combination 

to turn it off.

Figure 7 - 37
Disconnect

Win Vista

Win 7
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12. If you click the Mobile Partner close icon  a message will be displayed asking 
you to click OK to confirm the program exit and to terminate the connection. 

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn +  key combination to turn off 
the module (pay careful attention to this aboard aircraft - see “Wireless Device 
Operation Aboard Aircraft” on page 7 - 33).

14. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 38
Exit Prompt
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Text Messaging Service
In addition to standard internet services you may also send and receive SMS text
messages using the Mobile Partner program, if your service supports SMS.

Reading SMS Messages
1. An icon  will blink at the bottom of the Mobile Partner interface to notify you of 

any new messages received.
2. Click the Text icon  in the Mobile Partner Interface.
3. Select the Local > Inbox or SIM/USIM Card folder and select any message to 

read it.
4. Right-click the message and choose an option to reply, forward or delete the 

message.

Creating and Sending SMS Messages
1. Click the Text icon  in the Mobile Partner Interface.
2. Click the New button .
3. Enter the recipient’s number in the Send To... field or click the Send To... button to 

select an entry from the phone book, and click OK.
4. Type in the message details.
5. Click the Send button, Save button to send the message later or Close > Yes to 

save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SMS.
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Fingerprint Reader Module
The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install FingerPrint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 4.In-
stall FingerPrint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 39
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Save and Continue.
9. Enter a backup password and click Apply.
10. Close the fingerprint status window.

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 40
Fingerprint Status
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11. Right-click the taskbar icon  and select Start Control Center (and then swipe a 
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.
13. You can also run the Tutorial, or Product Tour video to get more information.

14. See “Help & Manual” on page 7 - 40 for further details.
15. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe, open the 
Control Center and access the Help menu.

Help

Figure 7 - 41
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.

Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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PC Camera Module
Make sure that the PC Camera module is on before installing the driver and use the
Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1 - 10) to
toggle power to the PC Camera module. When the PC Camera module is powered
on, the on-screen indicator will briefly be displayed. Make sure you install the driv-
ers in the order indicated in Table 4 - 1, on page 4 - 3.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera (note that
some versions of the camera application do not support the zoom function). Make
sure you access the application via the desktop shortcut.

Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.
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PC Camera Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 5.Install Camera Driver > Yes.
4. Click Next > Install > Finish to restart the computer.

OR
Click Next > Next > Install > Finish to restart the computer.
OR
Choose the language you prefer and click Next > Next > Finish.
OR
Choose the language you prefer and click Next > Next > Finish to restart 
the computer.

5. Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).

PC Camera Screen 
Refresh

If you find that the
screen refresh rate is
subject to lag or stutter-
ing, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion. 

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
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Figure 7 - 42
Audio Setup for PC 

Camera

Right-click
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Camera Application
The camera application is a video viewer for general purpose video viewing and test-
ing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 47) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 50 in
order to save file space, and help prevent system problems.

Pre-Allocating File 
Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
application (you may
need to set a folder first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
50.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 49), limit the file size of the captured video (see “Pre-
Allocating File Size/Space” on page 7 - 49) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut 
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency/Anti Flicker/Powerline Frequency.

Figure 7 - 43
Video Capture Filter
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Zoom
The camera program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 44
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 7) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or 
power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using
an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn
off/remove the unused device to save power.
Problems and Possible Solutions 8 - 7
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 13). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix B for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 10) to adjust.

The CD/DVD cannot be read. The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers appear when
typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 7).

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems and Possible Solutions 8 - 9
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The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3.5G
modules cannot be detected.

The modules are off. Check the LED indicator  and/or function key indicator
to see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 7). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn +  (3.75G) key combination(s) in order
to enable the modules (see “Function/Hot Key Indicators” on page 1 - 10).

Problem Possible Cause - Solution

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
8 - 10 Problems and Possible Solutions
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The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 10). Run the
BisonCap program to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

A yellow exclamation mark appears
alongside PCI Simple Communications
Controller (Other Devices) in Device
Manager. 

The MEI driver will fix this known issue. Install the MEI driver (see “MEI Driver”
on page 4 - 7).

Problem Possible Cause - Solution
Problems and Possible Solutions 8 - 11
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

e-SATA Port Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port. 

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

e-SATA /
Interface (Ports & Jacks) A - 1
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Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
A - 2 Interface (Ports & Jacks)
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Appendix B: Intel Video Driver Controls
The basic settings for configuring video are outlined in “Video Features - Win 7”
on page 1 - 16/“Video Features - Win Vista” on page 1 - 18.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 352MB) sys-
tem memory (RAM) as needed to the video system (the video driver must be in-
stalled). DVMT returns whatever memory is no longer needed to the operating
system.

DVMT Notes

DVMT is not local video
memory.

DVMT is not user-con-
figurable.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Intel Video Driver Installation B - 1
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Intel® Graphics & Media Control Panel
Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution/Display Properties control 
panel in Windows.

2. Click the Intel(R)... tab and click Graphics Properties (button).
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Double-click the Intel(R) G&M control panel in Windows. 

Figure B - 1
Intel® G&M 

Control Panel
B - 2 Intel® Graphics & Media Control Panel
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You may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right.

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure B - 2
Intel® G&M 

Control Panel Tabs
Intel® Graphics & Media Control Panel B - 3
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Display Devices & Options
Besides the built-in LCD you can also use an external monitor/flat panel display/TV
(TV through HDMI-Out port only), connected to the external monitor port or to the
HDMI-Out port (High-Definition Multimedia Interface) as your display device. The
following are the display options:

Intel Display Mode Description

Single Display One of the connected displays is used as the display device

Multiple Display - 
Clone Displays

Both connected displays output the same view and may be 
configured independently

Multiple Display - 
Extended Desktop

Both connected displays are treated as separate devices, and 
act as a virtual desktop

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

Table B - 1
Display Modes

Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.
B - 4 Intel® Graphics & Media Control Panel
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor
port or HDMI-Out port on the left of the computer.

To Clone Displays:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Clone Displays from the menu. 
4. Click Apply, and OK to confirm the settings change.
5. You can switch the Primary/Secondary Display from the menu.

Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

General Settings

Click General Settings
to access settings the
options for any attached
display. 

Figure B - 3
 Display > Multiple 
Displays (Clone)
Attaching Other Displays B - 5
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To Enable Extended Desktop:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Extended Desktop from the menu. 
4. Click Apply, and OK to confirm the settings change.

 Display Settings 
Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 4 
Display > Multiple 

Displays (Extended)

Click the appropriate monitor
icon and drag it to match the
physical arrangement you
wish to use (e.g. the second-
ary display may be extended
left/right/above/below  the
primary display).

Click General Settings to
make any adjustments re-
quired.
B - 6 Attaching Other Displays
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Configuring an External Display in Windows 7
You can also use the Screen Resolution control panel in Windows 7 to configure an
external display.
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Note that HDMI sup-
ports video and audio
signals.

Figure B - 5
Screen Resolution 
Multiple Displays

(Win 7)
Attaching Other Displays B - 7
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure B - 6 
Screen Resolution 

Multiple Display 
Options
(Win 7)
B - 8 Attaching Other Displays
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Using the Windows Logo Key  + P Key Combination to Switch Displays
You can also use the  + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Press the  + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P) to select the appropriate configuration from the

menu, and press Enter to confirm the selection.

Figure B - 7
 + P Display 

Configuration 
Selection
(Win 7)
Attaching Other Displays B - 9
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Configuring Other Displays from Windows Vista
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Windows Mobility Center control panel (Mobile PC > Adjust

commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preference, or click

Display Settings to access the control panel.

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

Figure B - 8
Windows Mobility 

Center & New 
Display Detected
B - 10 Attaching Other Displays
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Using Windows Vista Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port or HDMI-Out port, and 

turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 22).
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor” and click Apply.

Figure B - 9
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Dis-
play  is on the left, the Secondary
Display  is on the right.

2

1
2

Attaching Other Displays B - 11
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Intel Clear Video Technology
Intel Clear Video Technology is designed to help users get high-quality video play-
back, sharp image quality, precise color control and advanced support for the latest
High Definition displays without the need for expensive video cards etc. 

1. Attach your external display to the external monitor port or HDMI-Out port, and 
turn it on.

2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Single Display from the menu.
4. Select your TV as the Primary Display (i.e. the only display) 
5. Click Apply, and OK to confirm the settings change.
6. The wizard will now take you through the steps to set up high quality video support

for your external display (configure in either Automatic or Manual modes).

 TV Wizard 

Use the TV Wizard to
configure the external
display settings.

The wizard will take you
though any necessary
steps in order to config-
ure the optimal video
settings e.g HDTV For-
mat, Display Size and
Position etc.

Figure B - 10
Intel® TV Wizard

Manual
B - 12 Intel Clear Video Technology
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you will need to configure the audio output as per the instructions below.

Windows Audio Setup for HDMI
1. Connect a device with HDMI support to the HDMI-Out port.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Sound  (Hardware and Sound).
4. Click Playback (tab), and double-click SyncMaster.
5. Click the SyncMaster Properties tabs and adjust the settings as per your

requirements.
6. Click OK to close the Sound  control panel.

Figure B - 11
HDMI Audio 
Properties 

(SyncMaster)
HDMI Audio Configuration B - 13
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Processor

Intel® Core™ i7-620M Processor:
2.66GHz
32nm (32 Nanometer) Process 
Technology, 4MB L2 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Socket P Package

Intel® Core™ i5-540M Processor:
2.53GHz
32nm (32 Nanometer) Process 
Technology, 3MB L2 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Socket P Package

Intel® Core™ i5-520M Processor:
2.4GHz
32nm (32 Nanometer) Process 
Technology, 3MB L2 Cache & 
FSB 1066MHz - TDP 35W
rPGA988A Socket P Package

Core Logic

Intel® HM55 Chipset

Display

15.6” HD 16:9 Wide Screen (1366 * 768) 
/ HD+(1600 * 900) TFT LCD

Memory

Dual Channel DDRIII (DDR3) 
Two 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1066MHz
Memory Expandable up to 4GB 
(1GB / 2GB DDRIII (DDR3) Modules)

Video Adapter

Intel HM55 Integrated Chipset
High Preference 3D/2D Graphic 
Accelerator
DVMT Memory Architecture up to 352MB
Supports Microsoft DirectX® 10.0

BIOS

One 32Mb SPI Flash ROM
Phoenix™ BIOS

Storage

One Changeable 12.7mm(h) Optical 
Device (CD/DVD) Type Drive (Super 
Multi / Blu-ray Combo) 

Easy Changeable 2.5" 9.5 mm (h) SATA 
(Serial) HDD

Audio

Intel® High Definition Audio Interface
3D Stereo Enhanced Sound System
S/PDIF Digital Output
Built-In Microphone
2 * Built-In Speakers 1W, 8Ω

Keyboard & Pointing Device

Isolated Full Size WinKey Keyboard with 
Independent Numeric Keys
Built-in TouchPad (integrated scrolling 
key functionality) with Multi Gesture 
Function
Three Instant Keys (WWW, E-Mail, Silent 
Mode)
C - 2 Specifications
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Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) Note: MS Duo/ Mini SD/ RS MMC 
Cards require a PC adapter

Interface

Three USB 2.0 Ports
One eSATA Port
One HDMI Out Port
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One RJ-11 Jack
One RJ-45 LAN Jack
One DC-In Jack

Slots

One ExpressCard/34/54 Slot
Two Mini-Card Slots (USB/PCIe):
Slot 1 for WLAN Module with HMC Slot 
and PCIe Interface (Factory Option)
Slot 2 for 3.75G Mini-Card Slot with USB 
Interface (Factory Option)

Communication

Built-In 56K MDC Modem V.90 & V.92 
Compliant

10/100/1000 MB Base-TX Ethernet LAN

Intel® WiFi Link Module 5300 3*3 802.11 
a/g/n HMC with PCIe Interface (Factory 
Option)

3rd Party 802.11b/g HMC Wireless Lan 
Module with PCIe Interface (Factory 
Option)

3rd Party 802.11b/g/n HMC Wireless Lan 
Module with PCIe Interface (Factory 
Option)

Bluetooth v2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)

1.3M Pixel USB PC Camera Module 
(Factory Option)

UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be 
used in North America.

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Resume From Modem Ring

Power

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz
DC Output 19V, 3.42A or 18.5V, 3.5A (65 
Watts)

6 Cell Smart Lithium-Ion Battery Pack, 
47.52WH

9 Cell Smart Lithium-Ion Battery Pack, 
77.76WH (Factory Option)

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory 
Option)

Operating System

Windows® Vista (with Service Pack 2)
Windows® 7
Specifications C - 3
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Environmental Spec

Temperature 
Operating:   5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

374mm (w) * 256mm (d) * 37.9mm (h)
2.6 kg With 6 Cell Battery & ODD
C - 4 Specifications
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